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Copyright 

Copyright Notice 

Copyright © by BrightBox Software Pty. Ltd. ABN: 29 139 371 752. All rights reserved. No part of this publication may be 

reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language, in any form or by any means, 

electronic, mechanical, magnetic, optical, chemical, manual or otherwise, without prior permission of BrightBox Software Pty. 

Ltd. 

Disclaimer 

Except for the limited warranty described in the software license agreement, Brighbox Software Pty. Ltd. makes no 

representation or warranties with respect to the contents hereof and specifically disclaims any implied warranties of 

merchantability or fitness for any particular purpose. No dealer, company or person is authorised to expand or alter our 

warranties or this disclaimer. Any such representation will not bind Brightbox Software Pty. Ltd.  

Brightbox Software Pty. Ltd. reserves the right to revise this publication and to make changes from time to time in the content 

hereof without obligation of Brightbox Software Pty. Ltd. to notify any person of such changes. 

Trademarks 

Microsoft Excel is a trademark of the Microsoft Corporation. AutoCAD is a trademark of the AutoDesk Corporation. Any 

references made or implied to other products have been made to help describe functions used in the software. Every effort has 

been made to supply complete and accurate information. However, Brightbox Software Pty. Ltd. assumes no responsibility for 

its use, nor any infringements of patent or other rights of third parties which would result. 
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1. Introduction 

MudShark is the next generation earthworks estimating software that is simple enough for anyone to use; you can be 

productive within minutes of your first use. This guide compliments MudShark's simple and flexible user interactions helping 

you move from beginner to expert in very little time. 

The content of this guide has been designed so it can be read from cover to cover or skip to individual sections of interest. 

After reading this guide you will be able to: 

¶ Understand how MudShark works. 

¶ Confidently use our fully interactive 3D Viewport. 

¶ Manage your Projects and Plans. 

¶ Take Off complex Working Areas, Contours, Spot Elevations and Structures quickly and accurately. 

¶ Manipulate and reuse Materials and their Factors. 

¶ Calculate and understand the Results. 

¶ Trace where Materials originated from and has ended up. 

¶ Calculate how much Material is being removed from the site or brought in from off Site. 

¶ Produce stunning graphical images of your 3D Site. 

¶ Produce detailed reports of Stripping, Cut, Fill, Respread and Structure Volumes. 

 

Figure 1. MudShark interactive 3D visualisation  
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2. How MudShark Works 

Unlike most other cut and fill software MudShark uses Solid Modelling to calculate results for your Project. This means it is 

capable of producing much more accurate volume results with a richer visual display. In order to generate these results 

MudShark needs to build a 4D model of how the Site currently looks (Existing Site) and how the Site will eventually look 

(Proposed Site). These models are constructed using the Smart 3D Take Off tools to digitise the sites as they are represented in 

Plans. 

Take Off the elevations of the land with Contours and Spot Elevations, as well as denoting Structures that need to be 

demolished or built. MudShark will use this information to construct 4D models of both site stages (which you can view) and 

calculate what needs to happen to the Existing Site to produce the Final Site. From these Strata Operations MudShark creates 

solid 3D Entities, these in combination with Material and reuse factors are used to calculate the Results which get displayed in 

3D in the Viewport pane and in a grid in the Results pane. 

Workflow 

MudShark is made to fit into your existing workflow and there are 

few rules or restrictions on the order that you calculate your 

Project. However a suggested workflow of how you could work 

through your Project is: 

1) Insert Plans 

¶ Insert, Align and Scale the Plan(s) that are required for 

the Project. 

2) Site Take Off 

¶ Enter the Project's Working Area. 

¶ Enter each Site Stages surface elevations using Contours and/or Spot Elevations. 

¶ Nominate the boundaries and Materials of Structures as required. 

3) Calculate Results 

¶ Configure Ground Settings. 

¶ Calculate Results. 

¶ Navigate and validate 3D results. 

¶ Navigate and validate the results grid. 

¶ Export results. 

Figure 2. Suggested MudShark workflow 
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3. User Interface 

aǳŘ{ƘŀǊƪΩǎ ƛƴǘǳƛǘƛǾŜ ƛƴǘŜǊŦŀŎŜ ƛǎ ŘŜǎƛƎƴŜŘ ǘƻ ƘŜƭǇ you easily navigate the software and to complete your Project efficiently with 

a minimal learning curve. Modern user interface design components have been used allowing flexibility in how you interact with 

your interface. 

 

Figure 3. Main user interface components in MudShark. 

Pane Interaction  

MudShark panes are windows that you can have continuously open, allowing you greater efficiency and flexibility with how you 

work. 

You can change the position and size of your Panes. Panes can be in one of three states: 

¶ Docked to the edge of MudShark. 

¶ Embedded in the centre workspace area. 

¶ Floating anywhere on your screen(s). 

If a Pane you want to work with is not visible on your screen on the View tab in the Show Panes group you can click on the 

control that corresponds to the pane you want to see. And whether the pane has been closed, hidden, obscured or unpinned it 

will be shown to you in its last visible state. 
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Docked Panes can be Pinned so that they remain visible or Unpinned so they collapse to the edge of the screen. To change the 

Pinned state, click the Pin button in a docked panes 

title bar. 

To make an Embedded pane Docked to a screen 

edge: 

¶ Click with the right mouse button on the 
embedded panes tab. A context menu 
appears. 

¶ Click Dockable. 

To dock a floating pane or change the location of an 

already docked pane: 

¶ Click and hold in the title bar of the pane. 

¶ Drag the pane to the Docking Overlay control that represents the direction you want to dock the pane. 

¶ Hover over the side you want to dock the pane to a live preview of how the pane will be docked is displayed.  

¶ Release the mouse button to dock the pane. 

 

Figure 5.Docking Overlay controls appear when you drag panes around the screen to allow you to dock and embed them.  

Figure 4. Clicking on an Embedded panes tab with the right mouse 
button. 
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List Panes 

These panes contain a list of the items that can be made visible in 

the Viewport. They provide a means of viewing and modifying what 

you have entered into the Project. 

¶ Plan List pane contains all the Plans (and their layers) that 

have been inserted into the Project. 

¶ Take Off List pane contains all the Take Off Entities that have 

been added into the Project arranged into Containers 

grouped by the Site Stage they belong to. 

¶ 3D Site List contains all the 3D Entities that have been 

calculated from the Take Off for the Site arranged into 

Containers grouped by the Site Stage they are associated 

with.  

Change Visibility 

With Plans, Take Off and 3D Entities your Viewport can appear 

cluttered. You can clear up your view and focus clearly on your 

current task by changing the visibility of items within a List pane. 

Some of this is handled automatically when you change the View 

Mode. However if you want to override the default behaviour you 

can choose to show or hide any Item. 

Each item in a list contains a check box to the left of the item. This is the items visibility check box. If the item is visible there will 

be a checkmark inside this box. To change the visibility of an item select or clear the check box making the item visible or 

invisible respectively. 

Note: You can still change the properties of items that are invisible. 

Changing the visibility of a Container (An Item that can have sub-Items) will also update the visibility of its sub-Items. So you can 

quickly adjust the visibility no matter how many Entities you are interacting with; showing/hiding an entire Site Stage with a 

single click of the mouse button. 

Selection 

Items in the List panes can be selected by clicking on their names. When an Item is selected in a list it is also shown as selected 

in the Viewport. 

Figure 6. Take Off List pane with multiple Items 
visible in the Viewport. 
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If the item has children then all of its child items will be selected and highlighted in the Viewport. So you can select all Structures 

at once or select them one at a time. 

If a single item is selected then, where applicable, you will be able to edit information about that item in the Properties pane. 

When you first create an item it will be selected by default so you will be able to edit its properties if you need to as efficiently 

as possible. 

Deletion 

Select the Entities that you want to delete then press the Delete key on your keyboard. If you delete something by mistake you 

can undo the deletion. 

Some entries in the List panes cannot be deleted and will instead delete all the items that are the children of it. For example if 

you want to delete all Contours in the Existing Site stage you could Select the Contours item then Delete it. Each Contour in the 

Site Stage will be removed but the Contours container will remain. 

Expansion 

Some items in the list can be expanded by clicking on the arrow next to the item this will toggle the Item showing as expanded 

or collapsed. This can allow you to drill down to the smallest piece of information or collapse to a higher level to use a broad 

overview of your Project. 

Viewport Pane 

The Viewport is a view of the currently visible Items in all the List panes. This is where you perform Take Off from a Plan and 

view your 3D Site results. 

For more Information see 5. Using the Viewport. 

Properties Pane 

The Properties pane shows information about the current Project wide Entity selection. If a single item is selected then you will 

be able to edit information about that Item. If there is more than 1 Item selected then the Properties pane will contain a list of 

the number and type of Entities selected. 

Most List pane Containers can also be edited in the Properties pane. If you want to change the colour of the Existing Site Stage 

Contours you can select the Contours item then choose a new colour. All Contours that are already a part of that group will have 

their colour updated. 
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Figure 7. Properties pane showing information about the currently selected Entities. 

Results Pane 

This pane allows you to explore tabular views of your Results data that can then be exported to an XLS file readable by spread 

sheet applications. 

Project Details Pane 

Contains information about your Project which is useful when choosing a Project to open. Additionally this is where you can 

configure a number of Ground Settings which affect the calculation Results. 
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4. Viewport Modes 

Where it will increase the efficiency of performing your tasks, such as scaling Plans and performing Take Off, MudShark has 

utilised modes which apply to interacting with the Viewport. That is the current mode MudShark is in controls how the Viewport 

will respond to your interactions. 

In many other programs excessive use of modes can easily lead to confusion. MudShark keeps you constantly informed about 

the current mode of the Viewport in the: 

¶ Ribbon: the current mode indicators will be highlighted in the Home tab. 

¶ Task Panel: the current mode is displayed as the title. 

 

Figure 8. Active Modes are highlighted in the ribbon. 

View Mode 

The Viewport in MudShark has 2 View Modes: 

¶ Take Off mode is made for accurate Take Off. 

¶ 3D Site changes the camera to use perspective to give a more natural looking 3D experience. 

Note: In the image of the ribbon above. Take Off is the currently active View Mode. 

Each View Mode remembers the visibility of all of your Items. If you reactivate a View Mode it will set all Items to have the same 

visibility they had when that View Mode was last used. 

Active Site Stage 

When performing Take Off MudShark uses the Active Site Stage to know where to insert the Entities. This can either be Existing 

Site or the Proposed Site. 

The Active Site Stage in Figure 8 is the Existing Site which means that the next Contour that is drawn will be added to the 

Existing Site. To change the Active Site Stage to the Proposed Site click Proposed Site in the Take Off group on the Home tab. 

Take Off Task 

For each Take Off Entity you draw in MudShark you must first indicate what type of Entity you are taking off. The Task defines 

the type of Take Off Entity created. You can only have one active Take Off Task at any given time and each task has different 
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Tools that they can use. For example you can Take Off Contours with the Polyline or Transmute Tools but not with the Point 

Tool. 

 

Figure 9. Current Take Off Task is adding Contours to the Existing Site.  

Tools 

Tools control how the Viewport responds to interaction. There are many tools in MudShark including: 

¶ Draw Entities in the Viewport. 

¶ Select Entities in the Viewport. 

¶ Scale Plans. 

¶ Moving the camera in the Viewport. 

While a Tool is active its corresponding button is highlighted in the Ribbon or in the Viewport Toolbar. 

Some Tools are designed to be a Single Use Tool. That is once you have performed a single action with that Tool the previously 

active Tool is again activated. This is useful for Tools that are generally only going to be used once and are complementary to 

your main goal. 

For example if you are drawing Contours with the Polyline tool and you want to use the Zoom Rectangle to zoom in closer to an 

area of the Plan it is likely that you will only be using the Zoom Rectangle once. After the zoom is completed MudShark will 

reactivate the Polyline tool. 

Some Tools are Multi Use Tools. That is once you start using that Tool it stays active until you deactivate it or choose to use 

another Tool. Tools where you are likely to want to repeatedly perform the same action are usually going to be Multi Use Tools. 

For example when Taking Off Contours you will usually be drawing more than 1 Contour to have to click in the Ribbon to start 

drawing a new Contour each time would be inefficient. As such the Polyline Tool stays active until you activate another Tool. 
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5. Using the Viewport 

Most of the work you do in MudShark will be inside your Viewport. To maximise your efficiency with MudShark we recommend 

getting accustomed with how to move the camera around, draw, select and edit entities in the Viewport. 

 

Figure 10. The Viewport displaying a Project with the Working Area and Contours for the Existing Site Stage entered. 

The main areas in the Viewport pane are: 

¶ Workspace - The area of the Viewport dedicated to the Visual display. 

¶ Viewport Toolbar - Provides quick access to commonly used Tools to navigate around the Viewport Workspace. 

¶ Task Panel - Provides contextual text about the current Task as well as helpful editors when performing Take Off or 

other Viewport related Tasks. To find out more about using the Task Panel refer to Tasks within the 8. Take Off section 

of this document. 
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Navigating 

The most efficient means of navigating around the Viewport is directly interacting with the Viewport Workspace using the 

mouse and keyboard.  

A number of Viewport Tools require that the Viewport Workspace is active (has focus) before using them. The Viewport is 

activated when it is clicked in. To activate the Viewport ǘƻ ǇŜǊŦƻǊƳ ŀƴ ƻǇŜǊŀǘƛƻƴ ǘƘŀǘ ŘƻŜǎƴΩǘ ƛƴǾƻƭǾŜ ŎƭƛŎƪƛƴƎ όŦƻǊ ŜȄŀƳǇƭŜ ǳǎƛƴƎ 

the scroll wheel to zoom) we recommend that you click the right mouse button inside the Viewport Workspace. 

Pan 

 

To move the camera left, right, up and down you need to Pan it. The quickest way mid take off is to use your mouse: 

¶ Click and hold the mouse wheel button in the Viewport. 

¶ Moving the pointer in the direction you want to Pan. 

Note: You can also Pan with your keyboard. Press and hold one or more direction keys in the direction you want to Pan when the 

Viewport is active. 

Rotate 

 

To get a view of your Site from a different angle you can rotate the camera: 

¶ Hold down the Ctrl key. 

¶ Click and hold the mouse wheel button in the Viewport. 

¶ Moving the pointer will rotate the current view. 

Zoom 

 

Moves the camera in closer or further away, to change the Zoom in your Viewport: 

¶ Activate the Viewport. 

¶ Rotate the mouse wheel. 
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Zoom Fit 

 

Click Zoom Fit in the Viewport Toolbar and the camera will zoom so that all the currently visible Entities fit the Viewport. This is 

a great way to return to an overall view of your Site.  

Zoom Window 

 

If you need to Zoom to a particular area of your Site: 

¶  Click Zoom Window in the Viewport Toolbar. 

¶  Drag a rectangular area in the Viewport Workspace. 

The Viewport will then zoom in as tight as possible on that rectangle. 

 Top Down 

 

To move the camera to get a ōƛǊŘΩǎ eye view of your Site in either 3D Site or Take Off View Modes click Top Down in the 

Viewport Toolbar. 

Selection 

The Select tool enables you to select only the Take Off Entities that you have drawn and the 3D Site Entities that have been 

generated to calculate the cut and fill. 

 

Figure 11. The Select tool active for the entire Site.  

To enter Selection mode click Select in the Edit group on the Home tab. 

You can then click on an Entity in the Viewport to Select it. If the Viewport can select the Entity it will be highlighted and 

selected in the other Panes in the application. 



  

 

Copyright © 2012 Brightbox Software Pty. Ltd.  21  

 

Multiple Selection 

You can use the Select tool to select multiple Entities at a time. 

You can select a rectangular area of Entities by clicking and dragging a rectangle around the items you want to select. Any 

selectable Entity that crosses or is contained within the rectangular area will be selected. 

Alternatively you can hold down the Ctrl Key and Click on the individual Entities you want to select. 

Tip: To select all selectable Entities visible in the Viewport press Ctrl + A while the Select tool is active. 

Drawing 

To ensure the most accurate Take Off all drawing Tools are only usable in the Take Off View Mode. If you make any mistakes 

while drawing you can undo what you have done by Clicking Undo in the Quick Access Toolbar. Alternatively you can delete 

what you have drawn by Selecting the Entity and then pressing Delete. 

Polyline Tool 

 

Figure 12. The Contours Polyline tool active for the Existing Site Stage. 

A polyline is a continuous entity that is made up of one or more straight lines or arcs. To draw a polyline ensure Polyline is active 

in the Tool group on the Home tab. 

Drawing Straight Lines  

Straight lines in a polyline are drawn by clicking on the points of the shape you are drawing. If you are tracing a Plan that has 

vector data you can hold down the SHIFT key to snap to a Point. 

Drawing Arcs  

Drawing arcs has been streamlined with an intuitive drag operation into the normal take off procedure so that you can complete 

your take off as quickly as possible. 

¶ Click the start point. 

¶ Click and hold the left mouse button on the end point. 

¶ Drag the line until it becomes an arc. You will see an overlay showing where the circular arc will be drawn. 

¶ Release the mouse button when the arc is at the desired dimensions. 
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¶ You can now draw another arc, straight line or finalise the polyline. 

Note: MudShark arcs are circular, if you are unable to get the arc to fit perfectly you can split a single large arc up into smaller 

segments.  

Finishing a Polyline  

MudShark uses Smart 3D Take Off tools when drawing so what you are drawing will influence how you can finish drawing a 

Polyline. 

Right click will execute the default finalising operation for the type of entity you are drawing. If that entity is required to be a 

closed shape (e.g. A Boundary) the shape will automatically try and form a closed shape. If you are Taking Off a free form entity 

ǎǳŎƘ ŀǎ ŀ /ƻƴǘƻǳǊ ǘƘŀǘ ŘƻŜǎƴΩǘ ƘŀǾŜ ǘƻ ōŜ ŎƭƻǎŜŘ ǘƘŜ ǊƛƎƘǘ ŎƭƛŎƪ ǿƛƭƭ Ƨǳǎt end editing and will not try and form a closed shape. 

If you want to close a shape you can explicitly do so by clicking on the start point of that shape. 

Tip: Ctrl + J is the keyboard shortcut for closing a Polyline by joining the end point of a polyline to the start point. 

Note: If you right click and the Polyline is not valid for the type of Entity (e.g. a single point for a Contour) then MudShark treats 

this like cancelled input. 

Point 

 

Figure 13. The Spot Elevations tool active for the Existing Site Stage. 

Clicking Point in the Tools group on the Home tab will activate point drawing. 

Points are entered by moving the mouse over the Viewport and clicking where you want to insert the Point.  

Transmute 

Transmute allows you to pick a Plan Entity and if the Plan Entity is compatible with the Active Take Off Task create a new Take 

Off Entity based off it.  

To Transmute a Plan Entity: 

¶  Click the Transmute tool in the Tool group on the Home tab. 

¶  Select the Altitude Source in the Task panel. 

¶ Click on the Plan Entity you want to use in the viewport. 
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This interaction is the same as the interaction for Select. Like the Select tool you can Transmute multiple entities at a time by 

drawing a rectangular area. All Plan Entities that cross or are found within that area will be transmuted.  

Tip: You can transmute all the Entities on a layer or in a plan by clicking on the Plan or Layer name in the Plan List pane when the 

Transmute tool is active.  

 

Figure 14. Transmuting a group of Entities. 

Tip: When Transmute is active you can Transmute all visible Entities in the Viewport by making the Viewport active and then 

pressing Ctrl + A. Make sure that only the Entities that you want to Take Off are visible and that none of these Entities cross each 

other. 
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6. Projects 

A Project contains all of your work that you do relating to an individual Site. You can have multiple Projects but only 1 open at a 

time within MudShark. When MudShark is launched it immediately presents itself ready for the next project. 

Tip: If you want to view 2 Projects side by side you can open another instance of MudShark and open that Project. 

It is important when working in MudShark to regularly save the changes you make to your Project. To ensure that you don't lose 

any data we recommend regularly backing up your Data Folder and Database. 

Opening a Project 

To open a Project that you have already worked on: 

¶ Click the Project tab. 

¶ Click Open. 

¶ This will display a list of all the Projects that you can open including their details. 

¶ In the Open Project window click on the Project you want to open. 

¶ Click the Open button. 

 

Figure 15. The Open Project window allows you locate and open your Projects quickly. 

  










































































